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INTRODUCTION 
In Annotation Sets Part 3 you will learn how to work with annotation sets.  

An annotation set is basically a collection of defaults and layers, which can be saved as a single group. This makes it easy to 
change display properties for several objects at once by simply choosing from a menu. For example, one of your saved 
dimenison defaults can be grouped with one of your saved arrow defaults, and one of your saved text defaults, and a saved 
callout default. This combination can be used in one of your many saved annotation sets. Some other combination can be 
saved in another annotation set, and so on. 

ANNOTATION SETS STEP BY STEP 

1. Select File ⇒ New Plan From Template. The Choose Template File dialog displays. Find the template file you 
created in Annotation Sets Part 2 using the ½” Scale IN ONLY plan. If you do not have this template file you will 
need to go back to Annotation Sets Part 2 (available at www.chiefacademyhomedesign.com) and create it. 

 

2. Click the  Default Settings tool button to display the Default Settings dialog. Double-click Annotation Sets 

(you could also just click the  Annotation Sets tool button). The Annotation Sets dialog display. Note that 
there are already several annotation sets listed. All of these ship with the program. Click on one and you can 
modify any of its saved defaults and layer properties, which are listed on the right side of the dialog. Each of 
these annotation sets has its own Current CAD Layer, its own Layer Set, and its own defaults for 6 annotation 
objects.  

 

 

TIP TUTORIAL 
Using Annotation Sets Part 3 

http://www.chiefacademyhomedesign.com/
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To choose which annotation set will be active in your model, close any open dialogs and select an annotation set from the 
Active Annotation Set Control drop-down menu. The annotation set that you choose will be the one that is active in the 
model. It will be active in the entire model, all floors, elevations, sections, and CAD details. Whenever you place one of the 
annotation objects it will appear with the properties specified by the set of defaults and the layer set in the Annotation 
Sets dialog. 

 

 

3. In the Annotation Sets dialog, select ¼” Scale Annotations and note that CAD, Default is listed in the Current 
CAD Layer drop-down list box. You could choose any layer or you could define a new one. 

4. Click the drop-down arrow for the Dimensions drop-down list. You see all of the available saved multiple 
defaults. Click on any one of them to choose it and it will become the active default for the Dimensions 
annotation object. 
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Clicking the  icon will allow you to add a new default. Clicking the  icon will allow you to edit the selected 

default. Click the  icon to delete the selected default. You cannot, however, delete the selected default if objects in the 
plan are currently using it or if it is the only object left in the drop-down list. There must always be at least one object in 
the list. Note that all three of the scaled annotation sets (the ¼”, the ½”, the 1/8” Scale Annotations) display Use Active 
Layer Set as their Layer Set default. This means that when you activate one of the scaled annotations sets it will not 

change the layer set assigned to the current view. The other annotation sets (except for NKBA Annotations), such as the 
Electrical Annotations, do use a specific layer set.  The Electrical Annotations uses the Electrical Set, the Framing 
Annotations uses the Framing Set, the HVAC Annotations uses the HVAC Set, the Plot Plan Annotations uses the 

Plot Plan Set, and the Roof Annotations uses the Roof Plan Set. 

If you were to activate the Plot Plan Set by selecting it from the Active Annotation Set Control drop-down menu, then the 

active view would change its layer set to the Plot Plan Set. You can learn more about working with layer sets and 
annotation sets in Annotation Sets Part 4. 

The chosen multiple defaults have been set up and named in a way that they are clearly associated with the selected 
annotation set. 

5. In the Annotation Sets dialog, from the list of Annotation Sets, click on Plot Plan Annotations. Click the Rich 

Text  edit icon button. The Rich Text Defaults-Plot Plan Rich Text Defaults dialog displays. Note that the 
number in the Font Height edit box is 30”. Go to the Appearance tab. The layer is not the Text layer but on a 
uniquely assigned layer for the plot plan, the Text, Plot Plan layer. Click the Cancel button.  

This begins to reveal some of the flexibility and power of combining both the multiple defaults and layers into annotation 
sets. Once you have your annotation sets set up you can quickly switch between them to employ a variety of annotation 
schemes into your construction documents. In Annotation Sets Part 2, you created a new ½” Scale IN ONLY annotation 
set. We will now create a scheme using a unique font, a unique arrow style and callout style.  

6. With ½” Scale IN ONLY Annotations selected, note that the Current CAD Layer is the CAD, Default layer, upon 
which many objects reside. So you could get some layer control by assigning a specific layer. Click the Define 
button. The Layer Display Options dialog displays. Find the CAD, Default layer. Select it and click the Copy 
button. Rename the copy to CAD, IN ONLY. Change the color for this layer to a green color by clicking on the 
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color bar in the Properties for “CAD, IN ONLY” section. Once you have changed the color click OK to close the 
Layer Display Options dialog. 

 

7. Click the Dimensions drop-down list arrow. Select ½” Scale IN ONLY Dimension Defaults (created in Annotation 

Sets 2). Click the  for Dimensions. The Dimensions Defaults- ½” Scale IN ONLY Dimension Defaults dialog 
displays. Go to the Layer tab. The current layer displayed is the Dimensions, Manual layer.  Click the Define 
button. The Layer Display Options dialog displays. Click the Copy button. Rename the copy to Dimensions, IN 
ONLY. Change the color for this layer to a green color by clicking on the color bar in the Properties for 
“Dimensions, IN ONLY” section. Once you have changed the color click OK to close the Layer Display Options 
dialog. Go to the Primary Format tab. In the Format section, make sure “ is selected from the Unit drop-down 
list. Click OK to close the Manual Dimensions Defaults- ½” Scale IN ONLY Dimension Defaults dialog. 

8. Click the Rich Text drop-down list arrow. Select the ½” Scale Rich Text Default and click the  icon to display 
the New Default dialog. Change the name to ½” Scale IN ONLY Rich Text Default. Click OK. The Rich Text 
Defaults- ½” Scale IN ONLY Rich Text Default dialog displays. The height, 3”, is right because we copied the ½” 
Scale Rich Text Default. Go to the Appearance tab. Change the layer to the CAD, IN ONLY layer. Click OK. 

9. In the Text drop-down list window, ½” Scale Text Default should be showing. Click the  icon to display the 
New Default dialog. Change the name to ½” Scale IN ONLY Text Default. Click OK. The Text Defaults- ½” Scale IN 
ONLY Text Default dialog displays. Go to the Line Style tab. In the Line Options section, click the Define button 
for Layer. In the Layer Display Options dialog, click the Copy button. Name the copy Text, IN ONLY. In the 
Properties for “Text, IN ONLY” section, click the Define button for Text Style. The Saved Text Styles dialog 
displays. Click the Copy button. The New Default dialog displays. Name the copy, Default Text IN ONLY Style. 
Click OK. The Text Style Defaults-Default Text IN ONLY Style dialog displays. In the Size section, change the 
Character Size to 3”. Click OK. Click OK to close the Saved Text Styles dialog. Change the color to a green color 
and then click OK to close the Layer Display Options dialog. Click OK to close the Text Defaults- ½” Scale IN 
ONLY Text Default dialog. 

10. In the Callout drop-down list window, ½” Scale Callout Defaults should be showing. Click the  icon to display 
the New Default dialog. Change the name to ½” Scale IN ONLY Callout Default. Click OK. The Callout Defaults- 
½” Scale IN ONLY Callout Default dialog displays. On the Callout tab, the radio button for Circle should be 
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selected, which is what we want.  Go to the Line Style tab. Change the layer to the Text, IN ONLY layer. Go to the 
Text Style tab. Select the radio button for Use Layer for Text Style. Click OK. 

11. In the Markers drop-down list window, ½” Scale Marker Default should be showing.  Click the  icon to 
display the New Default dialog. Change the name to ½” Scale IN ONLY Marker Default. Click OK. The Marker 
Defaults- ½” Scale IN ONLY Marker Default dialog displays. On the Line Style tab, change the color to a green 
color. Click OK to close the Marker Defaults- ½” Scale IN ONLY Marker Default dialog. 

12. Follow the same procedure for the Arrows. 

For Layer Set, you could select another appropriate layer set, such as the Default Set, press the Define button, make a 
copy of the layer set, rename it and define which layers will display and set other properties. For this exercise, we will stick 
with using the Use Active Layer Set selection. 

You have now created a ½” Scale IN ONLY annotation set with it unique features. Note how easy it would be to copy this 

set, make only a few changes to create similar ¼” and 1/8” schemes. We now need to make the ½” Scale IN ONLY 
annotation set, the active annotation set. 

13. Click OK to close the Annotation Sets dialog. If the Default Settings dialog is open, click Done. From the Active 
Annotation Set Control drop-down menu, select ½” Scale IN ONLY Annotations. 

14. To see the results of how your new annotation set looks draw a quick building with 4 walls. 

15. Click the  End to End Dimension tool button from the Dimension Tools drop-down menu. 

16. Draw a dimension to show the distance between the left exterior wall of the building and the right exterior wall.  
Draw another dimension between the rear and the front exterior walls.You will need to zoom in quite close to 
see the dimensions. Notice how the dimension is following the rules of the annotation set. 

17. Click the  Leader Line tool button. Place some text. 

 

18. Click the  Callout tool button and place a callout. 

Chief Architect has made it easy and efficient to create, edit, and define different annotation sets. You can make objects 
appear quite different using one annotation set versus using another annotation set. You can quickly switch between the 
different annotation sets with just a few clicks. And because you developed a little bit of layer control strategy you can turn 
on or off the entire annotation set and all its objects in the model. 
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19. Display the Layer Display Options dialog. Turn off the display of Dimensions, IN ONLY layer, the CAD, IN ONLY 
layer, and the Text, IN ONLY layer. Click OK. 

20. Click the  Undo tool button (click 3 times if you used the Active Layer Display Options palette to turn off 
the layers) to turn the Text, IN ONLY, the Dimensions, IN ONLY layer and the CAD, IN ONLY layer back on. 

21. Select ¼” Scale Annotations from the Active Annotation Set Control drop down list. 

22. Click the  End to End Dimension tool button from the Dimension Tools drop-down menu. Draw a 
dimension to show the distance between the left exterior wall of the building and the right exterior wall. Now 
everything you draw will be following the rules of the ¼” Scale Annotations set. 

 

If you make a change in the model to a default that is partly the current annotation set, it changes the annotation set but 
it is still the same annotation set. It has just been modified. Let’s look at an example. 

23. Click the  Rich Text tool button to activate it on the Annotation toolbar. Double-click it to display the Rich 
Text Defaults- ¼” Scale Rich Text Default dialog.  Change the default color to red and then click OK to close the 
dialog. Its still the same annotation set, but its properties have been changed. Place some text in the plan to see 
the effect. 

 

If you change a default to something different than the one being used, it alters the current annotation set. It is no longer 
the same set. Let’s look at an example of this. 

24. Display the Default Settings dialog. Under Text, Callouts and Markers, double-click Rich Text. The Saved Rich 
Text Defaults dialog displays. Select 1/8” Scale Rich Text Default from the Currently Active Rich Text Defaults 
drop-down list. Click OK. Click Done to close the Default Settings dialog. Note the name in the Active Annotation 
Set Control drop down list has changed to Using Active Defaults. 



                     

Using Annotation Sets Part 3 Chief Architect X9 

 

7 
 

25. Click the  Active Defaults tool button to display the Active Defaults dialog. You see Active Defaults listed in 
the Currently Using drop-down list in the Annotation Sets section. You have a choice. You can either add the 
modified configuration by clicking the Define button, or you could select another annotation set from the 
Currently Using drop-down list and click OK. Once you click OK, you lose your option to add a new annotation 
set. If you go back to the Active Defaults dialog, you will not see the Active Defaults listed in the Currently Using 
drop-down list. 

26. Select ¼” Scale Annotations from the Currently Using drop-down list. Click OK. Click the  Active Defaults 
tool button to display the Active Defaults dialog. Click the arrow for the Currently Using drop-down list. Active 
Defaults is no longer listed. Click OK. 

I have shown you a little about the annotation sets and the flexibility and the power it offers you. Since these defaults and annotation 
sets save with your plan or layout, you can greatly increase your productivity by putting your annotation settings into your template 
plan. Annotation settings can also be imported and exported using the File menu. 
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